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Quark XML Author 2015 ReadMe 

The staff of Quark Software Inc. would like to thank you for selecting Quark® XML 

Author to be your XML authoring solution. 

Quark XML Author is a mature XML editing solution in intelligence, 

pharmaceuticals, European governments, and now DITA. 

Quark XML Author supports the following Display Languages within Microsoft 

Word: English, French, Japanese and Spanish. 

This document provides details on system requirements, installation procedures, 

changes in the software, and technical support information.
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System requirements 

Quark XML Author requires the following minimum hardware configuration: 

 Processor: Intel Core i3, 2 Ghz or equivalent, (Intel Core i5/i7, 3.4 Ghz or •

faster recommended) 

 4GB of RAM (for 32-bit Word) or 8 GB of RAM (for 64-bit Word), (16 GB •

recommended) 

10 GB of available hard disk space •

 Display with a 1024 x 768 or higher resolution monitor •

 Peripherals suitable for Microsoft® Word authoring •

 DVD-ROM drive for installation from DVD (not required for installation •

from download) 

The recommended hardware configuration helps achieve optimal performance, 
which may vary based on the document size, complexity of content and product 

customization.  

Quark XML Author performance may also be affected if multiple Windows 
applications are running concurrently. 

 

Quark XML Author requires one of the following operating systems: 

 Windows 7® 32-bit (Enterprise, Professional or Ultimate) •

 Windows 7® 64-bit (Enterprise, Professional or Ultimate) •

 Windows 8® 32-bit •

 Windows 8® 64-bit •

 Windows 8.1® 32-bit •

 Windows 8.1® 64-bit •

Windows 10® 32-bit •

Windows 10® 64-bit •

 

Quark XML Author 

Microsoft Office Word 2010 32-bit, Professional Edition •

Microsoft Office Word 2013 32-bit, Professional Edition (Build 4849.1000 or •

later)  
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Microsoft Office Word 2016 32-bit, Professional Edition (Semi-annual•

Channel: Version 1708, Build 8431.2236 Released on March 13, 2018)

Microsoft Office Word 2016 64-bit, Microsoft Office 365 ProPlus (Semi-•

annual Channel: Version 1708, Build 8431.2236 Released on March 13,

2018)

 Quark XML Author provides localized language support for: 

English•

French•

Spanish•

Japanese•

 Prior to Windows 8, Quark XML Author Japanese requires Microsoft Office IME 

2010 32-bit. 

 For Windows 8.0, 8.1 and 10, Quark XML Author Japanese requires one of the 

following: 

Office 2010 Japanese IME add-in for Windows 8 (www.microsoft.com/en-•

us/download/details.aspx?id=35839).

Quark XML Author requires one of the following versions of the Microsoft® .NET 

framework: 

.NET 4.6.2: https://www.microsoft.com/en-us/download/details.aspx?id=53345•

.NET 4.7: https://www.microsoft.com/en-us/download/details.aspx?id=55170•

In addition, the following components are required for installation: 

.NET Programmability Support. See “Enabling .Net Programmability“.•

Shared Add-in Support Update for the Microsoft .NET Framework 2.0•

(KB908002). It is available for download at Microsoft’s Download Center:

support.microsoft.com/kb/908002.

If you want to author math equations, then Design Science MathType™•

version 6.9 or later is required.

Math equations are saved to MathML format and to a specified image format. In
addition, performance can be enhanced if math equations are also saved to a binary

OLE format.

Once the required installation of Word and other required software is complete, you

may install Quark XML Author

http://www.microsoft.com/en-us/download/details.aspx?id=35839
http://www.microsoft.com/en-us/download/details.aspx?id=35839
QuarkXPress Server
#details.aspx?id=53345
Error Code: 10493 - The Hyperlink with name *  * does not exist. : Error Context :  Layout=Quark

http://support.microsoft.com/kb/908002/
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Quark XML Author installation 
procedure 

Installing Quark XML Author is a straightforward process. The installation wizard 

will guide you through each step of the process. 

Before you begin to install Quark XML Author, be certain that all required software, 

including Microsoft Word, has already been installed. Also, run Office Updates at 

Microsoft.com to ensure the latest version is installed. Quark XML Author explicitly 

uses these latest features. Close Microsoft Word and Microsoft Office. 

 To install Quark XML Author  

Ensure that you have internet access. If any of the common Microsoft libraries are 1
not installed on your system, the installation process attempts to download them. 

If previous versions of Quark XML Author  have been installed, perform the 2
following steps: 

Use Control Panel to uninstall all previous versions and patches. 1.

Use Windows Explorer to delete the installation folder. 2.

 

The default installation folder is: 

For Quark XML Author 32-bit on a 32-bit machine: C:\Program •

Files\Quark\Quark XML Author\

 

For Quark XML Author 32-bit on a 64-bit machine: C:\Program Files •
(x86)\Quark\Quark XML Author\ 

For Quark XML Author 64-bit: C:\Program Files\Quark\Quark XML •

Author\  

 

From the installation media, double-click the “setup.exe” file and follow the 3
instructions on the screen. 

Quark XML Author has been successfully installed. 
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Enabling .NET programmability  

Quark XML Author requires Word programmability through the .NET Framework. 

You can enable this feature through the Windows Control Panel. The Microsoft 

description of this feature reads, “Primary interop assembly that allows Microsoft 

Office Word programmability with .NET Framework version 1.1 or greater.” 

To enable support for .NET programmability: 

Choose Control Panel > Add or Remove Programs. 1

Locate and select Microsoft Office 2010, 2013 or 2016, respectively. 2

Click Change. 3

In the Change your installation of Microsoft Office dialog box, click Add or 4
Remove Features. 

Click Continue. 5

Ensure that Word is checked. 6

Check Choose advanced customization of applications. 7

Expand Microsoft Office > Microsoft Office Word > .NET Programmability 8
Support. 

Check Run from My Computer. 9

Click Continue. 10

The configuration process starts. 

Click Close. 11

Word is configured for programmability with the .NET Framework. 
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Changes in this version 

This section describes major changes, new features, and new support in this version 

of Quark XML Author. The details provided apply to the core Quark XML Author 

functionality which is a component of all Quark Content Management System 

Adapters. 

New features in 6.3 

 Version 6.3 of Quark XML Author includes the following enhancements: 

Performance improvements: •

Microsoft Word Reviewer for XML Author performance has been •

improved for parallel review by 50-90% depending on number of 

reviewers and content complexity. 

Improved save and check-in performance by limiting the check-in •

process to modified components. 

 

Smart Content toolkit integration: •

Smart Content schema support in XML Author. •

Added a Smart content builder component to generate XML Author •

schema files using Flash Translation Layer. 

Integration with dynamic configuration to push configuration updates. •

 

Authoring features: •

Apply case changes: Sentence case, lowercase, UPPERCASE, Capitalize •

Each Word and tOGGLE cASE. 

Managing smart quotes and straight quotes •

 

Enhanced support for tracked element revisions. •

Added progress bars during document open and Word Reviewer for XML •

Author export and import operations. 

 

Configuration changes •

The following configuration files have been modified in this release: 

BusDoc configuration: •
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config.xml •

AppConfig.xml •

XpressSchema.xsd •

 

DITA configuration: •

sme-config.xml •

sme-map-config.xml •

AppConfig.xml •

XpressSchema.xsd •

 
 
 

New features in 6.2 

 Version 6.2 of Quark XML Author includes the following enhancements: 

Standards compliance: 

DITA 1.2 reuse milestone •

DITA configuration now includes support for conkeyref and keyref (as •

keywords, hyperlinks and topic references). •

The Insert tab provides an option to define keys in a DITA map. •

Keys defined in a map are listed on the canvas as well as the DITA map •

navigation pane. 

Phrases and/or hyperlinks can be inserted as a variable reference in •

DITA topics. 

Insert Hyperlink and Phrase Attribute Panel dialog boxes allow key •

usage for variables defined in the DITA map. 

 
 

The Review tab now supports the Display for Review feature of Microsoft •

Word. The user experience for markup is the standard Microsoft Word 

experience. 

 

Performance improvement - Table operations: Application performance when 

deleting multiple columns and making changes to text close to a table has been 

improved by 20%. 

Usability enhancements: 

Additional languages •

Authoring support includes Chinese (Traditional), Chinese (Simplified), •

Japanese, Korean and Vietnamese. 
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Bidirectional languages like Arabic and Hebrew with right-to-left (RTL) •

and left-to-right (LTR) text runs are supported 

 

Headings and Section titles in a referenced section can now be selected to •

insert cross-references. 

Paste operations now support tables with merged rows and text containing •

hyperlinks. 

 

New features in 6.1 

Version 6.1 of Quark XML Author includes the following enhancements: 

Infrastructure upgrades: 

Quark XML Author now supports.NET Framework 4.7 •

 

Performance Improvements: 

Applying styles to entire tables: Application performance when applying •

and removing colors to an entire table has been improved. 

 

Usability enhancements: 

The cross-reference feature has been enhanced and now allows greater control over 

custom cross-references. 

Configuring custom cross-references: Custom cross-references can now be •

made read-only using the CustomTextReadOnly attribute. 

Editing custom cross-references:  Read-only custom cross-references can •

now be edited using Cross-reference- Edit. 

Marking editable cross-references as read only: Editable custom cross-•

references can now be made read only using Cross-reference - Mark as 

Read Only. 

 

New features in 6.0 

Version 6.0 of Quark XML Author includes the following new features and 

enhancements: 

 New features: 

Navigation Pane: The Navigation pane displays the DITAMAP as table of •

contents. It is now possible to navigate to child topics and visually edit the 

structure of a DITAMAP. Topics, sub maps and child nodes can be moved 

around within the map. 

Parallel Word Review: Word documents can now be reviewed •

simultaneously by multiple reviewers. 
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Infrastructure upgrades: 

Quark XML Author now supports Word 2016 64-bit and Office 365 64-bit. •

 

Enhanced DITA support encompassing progress toward DITA 1.2 •

compliance. 

Enhanced content reference types. •

Updated reference infrastructure to support DITA key references. •

Enhanced DITA map editing, making it easier to build reusable outlines •

from an existing content corpus. 

 
 

Performance Improvements: 

Open performance improvement: Word rendition has significantly •

enhanced Document open performance for server assets. 

Portion marks optimization: Portion marks can now be applied for a •

visible element in its element definition or in the SectionType. 

 

Usability enhancements: 

Offline access mode: Elements referred from the Quark Publishing Platform •

server will now be visible in the offline access mode. 

Multiple task panes: Multiple task panes can now be invoked via the •

extensibility interface. 

 

New features in 5.5 

Version 5.5 of Quark XML Author includes the following new features and 

enhancements: 

Implementation of the Fast Save feature has significantly reduced document •

save time. 

Reviewer workflow has been integrated into Quark XML Author. Quark XML •

Author documents can now be reviewed directly in Microsoft Word without 

the need for XML Author Add-in Installation. 

Quark XML Author now supports Word 2016. •

Cross Reference feature has been enhanced. •

Display for Review feature is now supported in Quark XML Author.   •

Hyperlinks are now supported for inline images. •

Enhanced support for Page Breaks in tables. •
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New features in 5.2.1.0 

Version 5.2.1.0 of Quark XML Author includes the following new features and 

enhancements: 

This version of Quark XML Author further improves quality and stability. •

Table operations performance has been enhanced. •

 

New features in 5.2 

Version 5.2 of Quark XML Author includes the following new features and 

enhancements: 

Removed dependency on .NET3.5. The onlypre-requisite forinstalling QXA •

now is.NET 4.5.1. 

Section Breaks are visible on the Canvas. •

Added the ability to insert a paragraph after read only paragraphs. •

Added the ability to download multiple referenced assets from the server in •

parallel. 

Smart Paste XSLTs have been modified to support importing of Tracked •

changes and User comments from Word documents. 

Improved performance for the following table operations: •

Inserting rows and columns •

Deleting rows and columns using the backspace key •

Cut, Copy and Paste Table row/column •

Aligning text in table cells •

Selecting table or table column •

Column distribution  •

Using the cursor to select a column when one page view is used •

 Invoking a context menu on a selected table •

 

Other performance Improvements: •

Keystroke performance has been improved especially when using the •

backspace key while typing 

Improved performance when switching between Word and QXA •

 Improved performance when opening QXA documents •
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New features in 5.1 

Version 5.1 of Quark XML Author includes the following new features and 

enhancements: 

Table performance – common operations are 40% faster than before in some •

documents. 

 Dynamic configuration – you can now manage and deploy configuration •

updates without reinstalling the full product. 

Windows 10 and Office 365 Certification. •

Add the ability to selectmultiple list items using keyboard navigation keys. •

 

New features in 5.0 

Version 5.0 of Quark XML Author includes the following new features and 

enhancements: 

Clean authoring canvas – empties used to manage insertion points are now •

removed by default, making the authoring experience align much closer to a 

native MS Word scenario. 

Better WYSIWYG table editing – you have more options to edit tables, •

including the ability to drag cell borders for resizing. 

 Track changes extension – you have an improved ability to asynchronously •

track changes contributed by multiple users. 

Smart Paste enhancements – options to better preserve formatting and •

support many common use cases in contextual menus. 

 Spell check – streamline proofing with enhanced spell check support. •

 Global performance improvements – improved typing, editing large tables •

(up to a 400% improvement for some documents) using Smart Paste, or 

managing tracked changes. For example, compared to 4.8.x, it now takes 3% 

of the original time to save complex documents with extensive changes. 
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Warnings 

This section describes any issues or changes to this version of the Quark XML 

Author that are considered higher-risk. 

The installation process now uses the Microsoft Windows Installer in order to be 

UAC compliant. Be aware that the Windows Installer may or may not require a 

reboot and it may or may not reboot automatically depending on the version of the 

operating system and Windows Installer currently on the system. Quark 

recommends you save all work prior to launching the installation process. For 

example, in all versions of XP the system prompts you to reboot and in Vista SP1 or 

earlier the system reboots automatically. For more information on the behavior of 

the Microsoft Windows Installer, see support.microsoft.com/kb/958655. 

All pre-4.0 configurations must be updated. 

Table templates are not backwards compatible. New table templates must be created 

for pre-4.0 solutions. 

Outline View 
Modifying a Quark XML Author document in the Outline View may corrupt the 

document. 

Ruler 
Any changes made using the Ruler feature are not saved in the Quark XML Author 

document. 

Spell Check 
The Spell Check feature uses the default dictionary of the current Microsoft Office 

Display Language. 

Word 2010 
When the Overtype feature is enabled, Quark XML Author occasionally deletes the 

adjacent Empty/Insertion Point and corrupts the document. Quark recommends 

using the XML Author Open feature rather than the standard Word Open feature 

whenever possible. When opening XML documents, this gives Quark XML Author 

additional opportunities to perform checks and validations as the document is 

opening. If Word prompts you with the message “DTD is prohibited”, please ensure 

that you are using the XML Author Open feature so that the document opens 

properly. 

The Quick Access Toolbar is presented for both standard Word documents and 

Quark XML Author documents. Word commands that can change a document may 

corrupt a Quark XML Author document and therefore should not be executed from 

the Quick Access Toolbar. 

http://support.microsoft.com/kb/958655/
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Word 2010 allows the Ribbon to be customized. Quark XML Author hides standard 

Word features from the Ribbon that do not apply to an XML authoring session and 

that could corrupt a Quark XML Author document. Please consult with Quark 

professional services before customizing the Word 2010 Ribbon so that you do not 

expose these types of features. 

The Word 2010 Navigation Pane is not supported. Because the Document Map and 

Thumbnail View are part of the Navigation Pane, they are also not supported. 

Standard Quark XML Author solutions do not offer the Document Map and 

Thumbnail View. However, if you want to use these two features in a Word 2010 

Quark XML Author solution, please consult with Quark professional services about 

creating a separate configuration to facilitate this. 

Word 2010 co-authoring / simultaneous multi-user authoring is not supported.
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Setting the display language 

This section provides information for setting display languages in supported 

implementations of Microsoft Word. 

The Display Language of the user interface (menus, buttons, dialogs, etc.) in 

Microsoft Word may be set to any language for which you have installed Microsoft 

Office Language Packs. 

Quark XML Author supports the following Display Languages within Microsoft 

Word: English, French, Japanese and Spanish. 

Setting the display language for Word 2010, 2013 or 2016 

Launch the Microsoft Office Language Settings applet. 1

Windows 7: Start > All Programs > Microsoft Office > •
Microsoft Office 2010 Tools > Microsoft Office 2010 

Language Preferences. 

Windows 8: Right-Click on the desktop> Microsoft Office 2013 •

> Office 2013 Language Preferences. 

Windows 10: Click on the Windows Icon> All Apps > Microsoft •

Office 2016 Tools, choose Office 2016 Language Preferences. 

Windows 10 with the Anniversary Update: Click on the Windows Icon> •

Microsoft Office 2016 Tools, choose Office 2016 Language 

Preferences. 

 

The Microsoft Office Language Preferences dialog displays. 
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In the Display Language list box, choose the desired language. 2

Click Set as Default. 3

Click Ok. 4

Restart Microsoft Word 5

The display language is set. 

 

Setting the display language for Office 365 

You can change the display language for all of your Office 365 apps and services at 

the same time. Changing your display language setting doesn’t affect the language 

settings for anyone else. 

To set the display language: 

Sign into Office 365. 1

Go to Settings > Office 365 settings > Language. 2

On the Language page, select your language. 3

Click Save. 4

The display language is set. 
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Contacting Quark 

 The support portal allows you  tolog support tickets, track tickets, receive status 

notifications,chat with a technical support representative, search the Knowledge

Base, and access product documentation. 

 With direct access to documentation acrossall Quark software - from QuarkXPress 

and App Studio to QuarkEnterprise Solutions - you can find answers to your 

questions atyour convenience. Our support team is also available to help,either 

through our support portal, or via phone for our maintenancecontract customers. 

If you are a Quark customer and have a currentmaintenance or support contract 

your account has already been created for youusing your registered email address. If 

you do not have a supportcontract you can purchase a single support incident to get 

yourproblem resolved. If you have purchased or registered a supportedproduct, you 

are eligible for free support for the first 90days. 

In the Americas 

 For more details, please check out our support website.   

Outside the Americas 

 For countries outside the Americas, please visit the following sites to access your 

support account: 

Support Website 

 France - www.quark.com/fr/support •

Germany - www.quark.com/de/support •

http://www.quark.com/fr/support/
http://www.quark.com/de/support/
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Legal notices 

©2022 Quark Software Inc. and itslicensors. All rights reserved. 

Quark, the Quark logo, and Quark XML Authorare trademarks or registered 

trademarks of Quark Software Inc. and itsaffiliates in the U.S. and/or other 

countries. All other marks arethe property of their respective owners. 

Contact Information: 

Denver Corporate Address: 1225 17th Street Suite 2050 Denver, CO 80202 
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